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Kit Contents 

 Investigator® Quantiplex® Pro Kit (200) 
Catalog no. 
Number of 20 µL reactions 

 
387216 

200 

 

 Quantiplex Pro Reaction Mix 1 x 1.9 mL  

Quantiplex Pro Primer Mix  1 x 1.9 mL 

Male Control DNA M1 (50 ng/µL) 0.2 mL 

QuantiTect® Nucleic Acid Dilution Buffer 1 vial 

Quick-Start Protocol 1 
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Shipping and Storage 

Kit reagents should be stored immediately upon receipt at –30 to –15°C in a constant-

temperature freezer. After first use, store the kit components at 2–8°C. Avoid freezing the kit 

components. The QuantiTect Nucleic Acid Dilution Buffer may also be stored at −30 to −15°C, 

if desired. Quantiplex Pro Primer Mix must be stored protected from the light. DNA samples 

should be stored separately from PCR reagents. Under these conditions, the components are 

stable until the expiration date indicated on the kit. 

Intended Use 

The Investigator Quantiplex Pro Kit is intended for molecular biology applications in forensic, 

human identity, and paternity testing. This product is not intended for the diagnosis, prevention, 

or treatment of a disease. 

All due care and attention should be exercised in the handling of the products. We recommend 

that all users of QIAGEN® products adhere to the NIH guidelines that have been developed 

for recombinant DNA experiments, or to other applicable guidelines. 

Safety Information  

When working with chemicals, always wear a suitable lab coat, disposable gloves, and 

protective goggles. For more information, please consult the appropriate safety data sheets 

(SDSs). These are available online in convenient and compact PDF format at 

www.qiagen.com/safety, where you can find, view, and print the SDS for each QIAGEN kit 

and kit component. 
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Quality Control 

In accordance with QIAGEN’s ISO-certified Quality Management System, each lot of 

Investigator Quantiplex Pro Kits is tested against predetermined specifications to ensure 

consistent product quality. Investigator Quantiplex Pro Kit meets ISO 18385 requirements. 
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Introduction 

Human identification is commonly based on the analysis of short tandem repeats (STRs), single 

nucleotide polymorphisms (SNPs), or deletion insertion polymorphisms (DIPs), depending on 

the demands of an examination or on the sample quality. These multiplex assays used for 

human identification are complex systems that require a defined range of template input. 

The Investigator Quantiplex Pro Kit provides quantification of human genomic DNA, male 

DNA, and the integrity of DNA in a sample using quantitative real-time PCR. The kit is designed 

to confirm whether a sample contains sufficient DNA to enable DNA fingerprinting analysis 

(such as STR, DIP, or SNP analysis). Furthermore, the kit may help in establishing if a sample 

contains inhibitors that may interfere with such applications, thus necessitating further sample 

purification. In addition the DNA degradation system allows for a more precise assessment of 

the degradation status of the DNA. 

The Investigator Quantiplex Pro Kit uses a hot-start DNA polymerase enzyme and QuantiNova 

Guard additive. These unique components further improve the stringency of the antibody-

mediated hot-start.  

The kit also features a built-in control for visual identification of correct pipetting and Q-Bond®, 

an additive in the buffer that enables short cycling steps without loss of PCR sensitivity and 

efficiency. 

Principle and procedure 

The Investigator Quantiplex Pro Kit is a ready-to-use system for the detection of human and 

male DNA and parallel assessment of DNA degradation using quantitative real-time PCR. The 

kit provides fast and accurate quantification of human DNA in forensic database and 

casework samples. 
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Detection of amplification is performed using TaqMan® probes and a fast PCR chemistry. The 

dual-labeled probes contain a fluorescent reporter and a quencher at their 5' and 3' ends, 

respectively. During the extension phase of PCR, the 5' and 3' exonuclease activity of the DNA 

polymerase cleaves the fluorophore from the quencher. This results in detectable fluorescence 

that is proportional to the amount of accumulated PCR product. 

Target regions 

The target region for human DNA quantification (4NS1C®) is a 91 bp proprietary region 

present on several autosomes of the human genome. It was selected to give high sensitivity 

and is detected using the FAM™ dye channel on QuantStudio 5 Real-Time PCR Systems. 

Furthermore, the kit detects a longer autosomal amplification product (353 bp) targeting the 

same locus as the 91 bp 4NS1C autosomal target. Due to the differently sized autosomal 

targets, the longer autosomal target is more susceptible to DNA degradation, allowing for a 

precise assessment of the degradation status of the DNA. The larger 353 bp autosomal 

quantification target region is detected using the ATTO 550 dye channel on QuantStudio 5 

Real-Time PCR Systems. 

The target region for male DNA quantification was selected in order to give high sensitivity in 

the presence of mixed female/male DNA samples. It is detected as an 81 bp fragment using 

the ATTO 647N dye channel on QuantStudio 5 Real-Time PCR Systems. 

Internal Control 

In addition, the Investigator Quantiplex Pro Kit contains a balanced internal amplification 

control that is used to test successful amplification and identify the presence of PCR inhibitors. 

This heterologous amplification system is detected as a 434 bp internal control (IC) in the 

JOE™ dye channel on QuantStudio 5 Real-Time PCR Systems. The IC is designed to be more 

sensitive to inhibitors than the human and the male quantification targets. The comparison of 

the CT values of the IC system for DNA standards with the CT values of the IC system for 
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unknown samples may provide an indication of potential inhibition of the reaction in the 

unknown samples. Therefore, even if the IC system reports the presence of inhibitors in the 

sample, the DNA quantification will typically provide a reliable result. The presence of 

inhibitors in the sample may affect the downstream application and must be considered. 

Laboratory validation with relevant inhibitors should be performed to determine criteria for 

detecting inhibition. 

Table 1. Targets, amplicon lengths, and channels on QuantStudio 5 Real-Time PCR Systems for Investigator Quantiplex 
Pro Kit 

 Target Amplicon length Channel Ploidy Copy number  

Human target, small 
autosomal (Human) 

91 bp FAM Diploid Multi-copy 

Human target, large 
autosomal (Degradation) 

353 bp ATTO 550 Diploid Multi-copy 

Human male target (Male) 81 bp ATTO 647N Diploid Multi-copy 

Internal PCR control 434 bp JOE N.A. Synthetic fragment 
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Quantiplex Pro Reaction Mix  

The Quantiplex Pro Reaction Mix contains a hot start DNA polymerase and Quantiplex Pro 

reaction buffer. The DNA polymerase is provided in an inactive state and has no enzymatic 

activity at ambient temperatures. The antibody-mediated hot-start mechanism prevents the 

formation and extension of nonspecific PCR products and primer–dimers during reaction setup 

and the first denaturation step. Therefore, this mechanism allows higher PCR specificity and 

accurate quantification. At low temperatures, the DNA polymerase is kept in an inactive state 

by the antibody and QuantiNova Guard, which stabilize the complex and improve the 

stringency of the hot start. After raising the temperature for 2 minutes to 95°C, the antibody 

and QuantiNova Guard are denatured and the DNA polymerase is activated, enabling PCR 

amplification. The hot start enables rapid and convenient room-temperature setup. 

Furthermore, the Quantiplex Reaction Mix contains the additive Q-Bond, which allows short 

cycling times on standard cyclers and on fast cyclers with rapid ramping rates. Q-Bond 

increases the affinity of the DNA polymerase for short, single-stranded DNA, reducing the time 

required for primer/probe annealing to a few seconds. In addition, the unique composition of 

the buffer supports the melting behavior of DNA, enabling short denaturation and 

annealing/extension times that result in an overall PCR run time of approximately 60 minutes. 

The Quantiplex Pro Reaction Mix is also based on the unique QIAGEN PCR buffer system. The 

buffer contains a balanced combination of KCl and NH4Cl, which promotes a high ratio of 

specific to nonspecific primer binding during the annealing step of each PCR cycle. This 

creates stringent primer annealing conditions, leading to increased PCR specificity. 

Male Control DNA M1 and standard curve 

DNA quantification standards are critical for accurate analysis. We strongly recommend a 

27-fold dilution series with 4 concentration points in the standard curve for each assay. The 

Control DNA contains pooled male DNA at a concentration of 50 ng/µL. To ensure pipetting 

accuracy, the minimum input volume of DNA for dilutions should be 5 µL. The standard curve 
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is designed to be easily set up using a convenient 1:27 dilution series. If using QuantiTect 

Nucleic Acid Dilution Buffer to dilute the Control DNA, the dilutions are stable for at least 

1 week at 2–8°C. 

Important: Male Control DNA M1 is optimized for use with the Investigator Quantiplex 

Kits only. 

Templates for routine work 

In order to streamline the instrument setup and the analysis of the results on the QuantStudio 

5 Real-Time PCR Systems, QIAGEN has developed a set of template files. Download the 

template files from the product resources page at www.qiagen.com/QPpro-template-files. 
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Equipment and Reagents to Be Supplied by User 

When working with chemicals, always wear a suitable lab coat, disposable gloves, and 

protective goggles. For more information, consult the appropriate safety data sheets (SDSs), 

available from the product supplier. 

Equipment 

 Cooling device or ice 

 QuantStudio 5 Real-Time PCR System 

Material 

 Pipettes and pipette tips  

 PCR tubes or plates (use thin-walled PCR tubes or plates recommended by the 

manufacturer of your thermal cycler) 

Reagents 

 Nuclease-free (RNase/DNase-free) consumables: special care should be taken to avoid 

nuclease contamination of all reagents and consumables used to set up PCR for sensitive 

detection of human DNA 

Investigator Quantiplex Pro Calibration Kit (cat. no. 387416) 

 Calibration Standard FAM, Calibration Standard JOE, Calibration Standard ATTO 550, 

Calibration Standard ROX, Calibration Standard ATTO 647N, Quantiplex Pro 

Calibration Buffer 
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Important Notes 

Selecting kits and protocols 

This handbook contains protocols and recommendations for DNA quantification using the 

QuantStudio 5 Real-Time PCR System. Real-time cyclers other than the one listed here or in 

HB-2335 Investigator® Quantiplex® Pro Handbook for Applied Biosystems 7500 Real-Time 
PCR Systems have not been validated by QIAGEN for DNA quantification using the 

Investigator Quantiplex Pro Kit.  

 
Contamination risks 

Do not remove the seal on the reaction plates once the amplification is complete. Removing 

the plate seal increases the risk of contaminating subsequent reactions with amplified product. 

All reaction mixtures should be set up in an area separate from that used for DNA isolation 

and PCR product analysis (post-PCR) in order to minimize the potential for cross-contamination. 

In addition, use disposable tips containing hydrophobic filters to minimize cross-

contamination. 

Controls 

No-template control (NTC) 

Replicates of NTC reactions should be included in each quantification run in order to detect 

contamination. NTCs should contain all the components of the reaction, except for the 

template. Quantification using the Investigator Quantiplex Pro Kit is highly sensitive; despite 

the fact that the reagents contained in the Quantiplex Kit undergo strict quality controls to 

assess that they are free of human DNA contamination, background DNA may be detected in 
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rare cases due to the high assay sensitivity. Take great care to avoid contamination when 

pipetting the NTC. 

We recommend performing NTC reactions at least in duplicate. 

Internal positive control 

An internal, positive control (detected using a TaqMan probe) is used to test for successful 

amplification and for the presence of PCR inhibitors. Primers, TaqMan probe, and template 

for the internal control are all contained in the Quantiplex Pro Primer Mix.  

Calibration of QuantStudio 5 Real-Time PCR System 

When using the QuantStudio 5 Real-Time PCR System with Investigator Quantiplex Pro, custom 

dye calibration for FAM, JOE, ATTO 550, ROX, and ATTO 647N is needed. To achieve 

optimal performance, calibrate with the Investigator Quantiplex Pro Calibration Kit (cat. no. 

387416). Refer to the instrument user guide for additional information on correct setup. 
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Protocol: Cycler calibration using the Investigator 
Quantiplex Pro Calibration Kit and QuantStudio 
5 Real-Time PCR System 

This protocol is optimized for use of the Investigator Quantiplex Pro Calibration Kit on the 

QuantStudio 5 Real-Time PCR System using QuantStudio Design and Analysis Software 

(v1.4.1 or higher).  

For general instructions on instrument calibration, refer to the QuantStudio 5 Real-Time PCR 
Instrument User Guide. 

Important points before starting 

 Set up calibration plate in an area separate from that used for DNA isolation and PCR 

product analysis (post-PCR). 

 Use QuantStudio 5 Real-Time PCR System-related consumables (optical 96-well reaction 

plates and optical adhesive films). 

 Use disposable tips containing hydrophobic filters to minimize cross-contamination. 

 Repeat-dispenser pipettes can be used to dispense 20 µL into all 96 wells of a plate 

assigned for one dye. 

 For repeat dispensers, use disposable, sterile, separately wrapped repeat-dispenser tips. 

 Always wear a suitable lab coat, disposable gloves, and protective goggles. Avoid 

touching plate wells, optical adhesive films, and bottoms of the plates. 

 We strongly recommend performing the regions of interest (ROI) calibration and 

background calibration before you perform the custom dye calibration with the 

Investigator Quantiplex Pro Calibration Kit. Further details on how to perform ROI 

calibration and background calibration can be found in the QuantStudio 5 Real-Time 
PCR Instrument User Guide. 
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Procedure A: Calibration plate setup 

1. Thaw kit components if required. Mix all kit components before use. 

2. Vortex each calibration standard for at least 5 s before removing an aliquot. 

3. Dilute each Investigator Quantiplex Pro Calibration Kit standard in a separate tube (e.g., 

a 5 mL reaction tube), as described in Table 2. 

Table 2. Dilution scheme for Investigator Quantiplex Pro Calibration Kit standards 

 Component Volume (µL)  

Calibration Standard FAM 23 – – – – 

Calibration Standard JOE – 23 – – – 

Calibration Standard ATTO 550 – – 23 – – 

Calibration Standard ROX – – – 23 – 

Calibration Standard ATTO 647N – – – – 23 

Quantiplex Pro Calibration Buffer 2277 2277 2277 2277 2277 

Total volume 2300 2300 2300 2300 2300  

  

4. Mix each calibration standard by vortexing for at least 5 s. 

5. Assign and label one separate optical 96-well reaction plate for each Investigator 

Quantiplex Pro Calibration Kit standard (5 in total). 

6. Dispense 20 µL of diluted Investigator Quantiplex Pro Calibration Kit standard FAM into 

the assigned dye-specific optical 96-well reaction plate.  

7. Close the plate with an optical adhesive film. 

8. Repeat these steps for each of the other remaining Investigator Quantiplex Pro 

Calibration Kit standards (JOE, ATTO 550, ROX, and ATTO 647N). 

9. Centrifuge plates briefly. Always protect plates from light. 

10. After calibration, store the calibration plates at −30 to −15°C in a constant-temperature 

freezer, protected from light. Calibration plates can be stored and reused for up to 

3 months. 
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Procedure B: Calibration protocol for QuantStudio 5 Real-Time PCR System 

1. Start cycler and enter Settings menu on the Home screen. Select Maintenance and 

Service. 

2. Click Calibrations, then Custom, and Custom Dye. 

3. Select Add Custom Dye. 

4. Enter QPP_FAM as a new dye name, confirm that Reporter is selected, and click Save. 

5. Load the QPP_FAM plate prepared in Procedure A into the instrument.  

6. Enter 60°C for the calibration temperature.  

7. Press Start. 

8. When the calibration is complete, the screen will display Calibration Complete. Press 

View Results to review details. The QPP_FAM calibration spectra should show the highest 

signals in filter x1-m1. For other QPP dyes see Table 3. 

Table 3. Calibrated dye filter signal 

 Custom dye Highest signal in filter  

QPP_FAM x1-m1 

QPP_JOE x2-m2 

QPP_ATTO550 x3-m3 

QPP_ROX x4-m4 

QPP_ATTO647N X5-m5 

  

9. Repeat steps 1 to 8 to calibrate for the following dyes: 

• QPP_JOE 

• QPP_ROX 

• QPP_ATTO550 

• QPP_ATTO647N 
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Procedure C: Adding the Quantiplex Pro dyes to QuantStudio Design and Analysis 
Software (v1.4.1 or higher) 

1. Open the QuantStudio Design and Analysis Software and select Tools > Dye Library. 

 

2. Click New and add all QPP dyes: 

• QPP_FAM 

• QPP_JOE 

• QPP_ROX 

• QPP_ATTO550 

• QPP_ATTO647N 

Important: Dye names entered in the Dye Library must match exactly the dye names 

entered on the QuantStudio 5 during custom dye calibration! 

Confirm that Reporter is selected for each dye and then click Save. 
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Protocol: Quantification of DNA Using the 
QuantStudio 5 Real-Time PCR System 

This protocol is optimized for use of the Investigator Quantiplex Pro Kit on the QuantStudio 5 

Real-Time PCR System using QuantStudio Design and Analysis Software (v1.4.1 or higher).  

For general instructions on instrument setup and other software versions, refer to the 

QuantStudio 5 Real-Time PCR Instrument User Guide. 

Important points before starting 

 Set up all reaction mixtures in an area separate from that used for DNA isolation and 

PCR product analysis (post-PCR). 

 Use disposable tips containing hydrophobic filters to minimize cross-contamination. 

 When using the QuantStudio 5 Real-Time PCR System with Investigator Quantiplex Pro, 

custom dye calibration for FAM, JOE, ATTO 550, ROX, and ATTO 647N is needed. To 

achieve optimal performance, calibrate with the Investigator Quantiplex Pro Calibration 

Kit. 

 Use the cycling conditions specified in the protocol. The cycling is optimized for this 

assay. 

 Use the template volume specified in the protocol. The reaction is optimized for use with 

exactly 2 µL template DNA. Do not use more than or less than 2 µL per 20 µL reaction. 

 Dilutions of DNA quantification standards in QuantiTect Nucleic Acid Dilution Buffer can 

be stored between 2 and 8°C for at least 1 week. 

 Optimal analysis settings are a prerequisite for accurate quantification data. Readjust the 

analysis settings (e.g., baseline settings and threshold values) for analysis of every 

reporter dye channel in every run. 



 

20  Investigator Quantiplex Pro Handbook for QuantStudio 5 Real-Time PCR Systems    04/2023 

Procedure A: PCR 

1. Mix all solutions thoroughly before use to avoid localized concentrations of salt. 

2. Prepare fresh serial dilutions of the Male Control DNA M1 according to Table 4. Vortex 

for at least 5 s, and centrifuge each dilution briefly before removing an aliquot for the 

next dilution. Use a new pipette tip for each dilution. Make sure not to introduce cross-

contamination. 

Note: Alternative standard curves are listed in Appendix on page 57.  

 
Table 4. Serial dilutions of Male Control DNA M1 

 Serial dilution of Control DNA 
(ng/µL) 

Control DNA (µL) QuantiTect Nucleic Acid Dilution Buffer (µL)  

50 Undiluted DNA – 

1.8519 5 130 

0.0686 5 130 

0.0025 5 130 

 
 

3. Thaw the template nucleic acids. 

Mix all solutions thoroughly before use to avoid localized concentrations of salt. 

4. Prepare a Master Mix according to Table 5. 

The Master Mix contains all components needed for PCR except the template (sample) 

DNA and nuclease-free water.  

Prepare a volume of Master Mix 10% greater than what is required for the total number 

of PCR assays to be performed. This should include positive and negative control 

reactions. 

Reaction setup can usually be done at room temperature (15–25°C). However, we 

recommend keeping the reagents, samples, and controls on ice or in a cooling device. 
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Table 5. Master Mix for DNA quantification 

 Component Volume per 20 µL reaction Final concentration  

Quantiplex Pro Reaction Mix 9 µL 1x 

Quantiplex Pro Primer Mix 9 µL 1x 

Total volume of Master Mix 18 µL – 

 
 

5. Mix the Master Mix thoroughly, and dispense 18 µL into the wells of a PCR plate. 

6. Add 2 µL QuantiTect Nucleic Acid Dilution Buffer to the NTC wells. 

Ensure that the NTC wells do not come in contact with human DNA. 

7. Add 2 µL control DNA dilutions or 2 µL unknown sample DNA to the individual wells and 

mix thoroughly. Close the plate.  

Mix carefully to avoid localized concentrations of salt. 

Table 6 shows a possible plate setup. Ensure that the Master Mix and template are 

thoroughly mixed. 

It is required to run duplicates of the control DNA dilutions for each assay and on each 

reaction plate. 

Table 6. Possible plate setup of reactions on the QuantStudio 5 Real-Time PCR System 

 Well contents  

  1 2 3 4 5 6 7 8 9 10 11 12  

 A 50 50 1.8519 1.8519 0.0686 0.0686 0.0025 0.0025 NTC NTC UNK UNK  

 B UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK  

 C UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK  

 D UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK  

 E UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK  

 F UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK  

 G UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK  

 H UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK UNK  

  All content in ng/µL. NTC, no-template control; UNK, unknown sample. 
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8. Open the QuantStudio Design and Analysis Software (v1.4.1 or higher). 

9. Several options to set up a run are described: 

 If you are using a template file and doing a manual plate setup, proceed to step 20 

to define DNA sample names and assign to the plate layout. Then proceed to step 25 

to start the run. 

 If you are using a template file and also use a TXT setup file for plate setup, proceed 

to “Procedure B: Run setup using a template file and a plate setup file”, page 35. 

 If you are not using a template file, proceed with step 10 below. 

The template file loads all of the settings needed to start an Investigator Quantiplex Pro 

run, including the standard curve settings, the cycling profile, and the targets needed for 

fluorescence acquisition. Download the template files from the product resources page at 

www.qiagen.com/QPpro-template-files. 
 

10. If you are not using a template file, select Create New Experiment. 
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11. In the Properties tab, confirm the following settings in Experiment Properties: 

 Instrument type:  QuantStudio™ 5 System 

 Block type:   96-Well 0.2 mL Block 

 Experiment type:   Standard Curve 

 Chemistry:   TaqMan® Reagents 

 Run mode:   Standard 

And then, click Next. 
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12. In the Method tab, adjust thermal profile by changing the holding times to those in Table 7. 

Change Volume to 20 µL.  

Data acquisition should be performed during the combined annealing/extension step. 

Click Next. 

Table 7. Cycling protocol using QuantStudio 5 Real-Time PCR System 

 Step Temperature Time Number of 
cycles 

Comment  

Initial PCR activation step 95°C 3 min – 

PCR requires an initial 
incubation at 95°C to 
activate the DNA 
polymerase 

Denaturation 95°C 5 s 

40 

  

Combined annealing/extension 60°C 35 s  
Perform fluorescence data 
collection 
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13. In the Plate tab, select Quick Setup. And then, in Plate Attributes > Passive Reference, 

select QPP_ROX. 

 

14. Still in the Plate tab, select Advanced Setup. Click Add 3 times, and then add the targets 

listed in Table 8. 
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Table 8. Assign targets and samples 

 Name Reporter Quencher  

Human QPP_FAM None 

Male QPP_ATTO647N None 

Degradation QPP_ATTO550 None 

IC QPP_JOE None 

 
15. Select the wells in use and assign all 4 targets by marking the boxes on their left. 

Important: Do not highlight the wells that are not in use (i.e., those without reaction mix). 

Including unused wells will significantly impact the scale of the x and y axes when 

viewing the data. 
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16. Still in Advanced Setup, open the Samples section and click Add to enter the sample 

names for the standards (e.g., Standard -1, Standard -2, etc.; or Std1, Std2, etc.) and 

NTCs. 

Note: Naming of standards is required for proper subsequent analysis with the QIAGEN 

Quantification Assay Data Handling Tool. 

Important: If replicates are needed, they should be assigned before you proceed to the 

next step. Define replicates by using the same sample name for 2 or more wells or by 

using the Biological Replicate Groups panel.* 

 

  

 
*  Instructions for using the Biological Replicate Groups panel are not covered by this handbook 
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17. Select the wells for the no-template controls (NTC) and flag them as negative control in 

Task by selecting the gray N button. 

Note: Leave the IC (QPP_JOE) task for NTC reactions set to U (“unknown”). In Samples, 

select the sample name NTC. 
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18. Select the wells for the standard curve and flag them in the Task column as standard by 

selecting the orange S button.  

Note: Leave the IC (QPP_JOE) task for standard reactions set to U (“unknown”). 
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19. Enter the concentration and select a sample name for each standard. Enter the quantity 

of DNA in the wells according to Table 4, page 20. 

 
  



 

 Investigator Quantiplex Pro Handbook for QuantStudio 5 Real-Time PCR Systems    04/2023 31 

20. In the Samples section, click Add to enter the names of the DNA samples. 

Assign DNA samples to the plate layout by clicking on the wells and checking the 

appropriate box on the left Samples panel. 
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21. At the top toolbar, select Analysis > Analysis Settings. 

 

22. In the CT Settings tab, under Default CT Settings, select the first Target. At the leftmost 

side of the window, uncheck the boxes beside Default Settings, Automatic Threshold, and 

Automatic Baseline. Do the same for the rest of the targets. 
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23. Enter the following settings for each target (Table 9), and then click Apply: 

Table 9. CT Settings 

 Target Threshold Baseline start Baseline end  

Degradation 0.125 3 15 

Human 0.2 3 15 

IC 0.05 3 15 

Male 0.2 3 15 

  

Important: Verify that options for Automatic Threshold and Automatic Baseline are 

deselected for all targets. Setting the appropriate threshold value may require further 

internal validation at your facility. 
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24. Optional: Before running the reaction plate, you can save the setup as an EDT template 

file:  

24a. Click File > Save as.  

24b. Enter a name for the template document.  

24c. Click Save again.  

If you do not want to save the setup as a template, proceed to the next step.  

25. Load the plate into the instrument. Ensure that position A1 on the plate is on the top-left 

side of the tray. 

26. Select the Run tab, and then click Start Run. 
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Procedure B: Run setup using a template file and a plate setup file 

1. Open the QuantStudio Design and Analysis Software (v1.4.1 or higher). Select Open. 

 

2. Select the EDT template file. 

3. Click File > Import Plate Setup, select the plate setup TXT file, and then click Apply. 

 

4. After successfully importing the plate setup, load the plate into the instrument. Ensure that 

position A1 of the plate is on the top-left side of the tray. 

5. Select the Run tab, and then click Start Run. 
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Procedure C: Data analysis 

Optimal analysis settings are a prerequisite for accurate quantification data. Check and 

readjust the analysis settings (i.e., baseline settings and threshold values) if needed for analysis 

of every reporter dye channel in every run. 

1. Open the run file using the QuantStudio Design and Analysis Software (v1.4.1 or 

higher). 

2. Before a standard curve can be created, standards must first be defined.  

Note: If standards had been defined before the run was started, proceed to step 4, 

below. 

3. Go to Setup and select Plate Setup. Define the wells that contain DNA standards as 

explained in steps 16–19 of “Procedure A: PCR” (starting on page 27). 

4. Select Analysis > Analysis Settings from the top toolbar and confirm that settings are set 

as described in Table 8. 

5. Click the Results tab, select the wells to be analyzed, and click Analyze. 

 

6. To view the standard curve, select Amplification Plot > Standard Curve from the 

drop-down menu.  
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7. Review standard curves for each target by selecting All Target. 

View the CT values for the quantification standard reactions, and the calculated 

regression line, slope, y-intercept, and R2 values. 

 

8. To export and save the results report, go to Export in the top bar.  

Ensure only the Results box is checked under Content.  

Click Customize.  
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9. Ensure All Fields are selected for export. Click Close.  
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10. In Export, click Browse, choose where you want to save your file, then click Open. 

  

11. Click Export. Save the file in XLS format.  
 

 

12. To interpret results, see next section “Interpreting Data Using the QIAGEN Quantification 

Assay Data Handling Tool”. 
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Interpreting Data Using the QIAGEN 
Quantification Assay Data Handling Tool 

The QIAGEN Quantification Assay Data Handling Tool is designed for accurate 

quantification, data analysis, and interpretation. The Opening Page worksheet contains 

information on version number and software requirements/compatibility. On the Configuration 

worksheet, the root directories for data processing, result import options, and default values 

for analysis criteria and thresholds can be set. Each worksheet contains an instruction button, 

which, when pressed, provides detailed instructions on using the functions of the specific 

worksheet. 
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Procedure 

1. Open QIAGEN Quantification Assay Data Handling Tool.  

2. If the cycler has been calibrated with the Investigator Quantiplex Pro Calibration Kit and 

if the Data Handling Tool is being used for the first time on your computer, a one-time 

update has to be conducted. For proper functioning of the Data Handling Tool please 

ensure that the QPP dyes have been named exactly on your cycler as described in the 

calibration section of this handbook. The one-time update will set proper dye naming in 

the Data Handling Tool. Save the Data Handling Tool afterwards on your computer. If 

you are using the Data Handling Tool the first time on your computer proceed to step 3. 

If the one-time update has already been done and the changes have been saved 

proceed to step 4. 
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3. Click on the blue One Time update (ABI 7500 & QuantStudio cyclers) button. 
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4. Click the Configuration worksheet tab and set: 

4a. root/home directory to save Quant batch files 

4b. root/home directory to import Quant result files 
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5. Target names should be assigned for the QuantStudio 5 Real-Time PCR System. Click on 

the Enter Defaults button and select ABI 7500/QuantStudio. Default names for the targets 

are “Human” (Human Target), “Male” (Male Target), “Degradation “(Degradation 

Target), and “IC” (Internal Positive Control). Defaults can be restored by clicking the Enter 

Defaults button.  

Note: The Male Degradation Marker is only available in the Investigator Quantiplex Pro 

RGQ Kit. 
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6. Threshold setting for the Quality Assessment can be changed/adjusted as needed. The 

default threshold settings are 

 Mixture index (Human/Male): 2 

 Degradation Index (Human/Degradation): 10 

 Inhibition Index (IC Shift): 1 

Note: Setting the appropriate threshold values may require further internal validation at 

your facility. 9948 will be filtered from the import, provided it is included in the section 

“Quantification QC Control Specification”. Removing it allows it to be kept in the final 

data set. 

Defaults can be restored by clicking the Enter Defaults button. 
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7. To import quantification results click the Quant Result Import worksheet tab. 

 
 

 
 
  



 

 Investigator Quantiplex Pro Handbook for QuantStudio 5 Real-Time PCR Systems    04/2023 47 

8. Click the Import Quant Data button. 
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9. Confirm that your data are in the necessary format. 

 
 

Your quantification data are now imported and the data analyzed. The Mixture Index, 

Degradation Index, and Inhibition Index are calculated and tagged as “Below Threshold”, 

“Possible Mixture”, “Possible Degradation”, or “Possible Inhibition”. 

 
10. Display options can be adjusted by clicking Display Settings: 

 Show Raw Data 

 Show Quantity Mean Values 

 Show CT Values 

Note: The Degradation Index is set to 10 as a default. Full STR profiles can be obtained 

with DNA fragmented to an average fragment size of approximately 300 bp. The default 

Degradation Index of 10 should allow differentiation between DNA fragments larger or 

smaller than 300 bp. 

Note: The Inhibition Index is set to 1 as a default. The IC acts as a quality sensor and 

reports the presence of inhibitors with a CT shift while quantification remains reliable. The 
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default value can be changed and adjusted for relevant degrees of inhibition. Therefore, 

laboratory validation should be performed to determine criteria for detecting inhibition. 
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General Interpretation of Results 

General considerations for data analysis 

Real-time PCR data are produced as sigmoidal-shaped amplification plots (when using a linear 

scale), in which fluorescence is plotted against the number of cycles. 

The threshold cycle (CT value) serves as a tool for calculation of the starting template amount 

in each sample. This is the cycle in which there is the first detectable significant increase in 

fluorescence. 

The optimal threshold setting depends on the reaction chemistries used for PCR. Therefore, an 

optimal threshold setting that has been established for another kit may not be suitable for the 

Investigator Quantiplex Pro Kit and may need to be adjusted. 

For DNA quantification using the Investigator Quantiplex Pro Kit, the analysis settings must be 

adjusted for both reporter dyes. 

Standard curve 

The standard curve is the best fit for a linear regression to the standard dilution series data. 

The equation is in the form 

y = mx + b 

where x = log concentration and y = CT. 
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The slope 

The slope (m) describes the PCR efficiency. A slope of –3.3 indicates 100% PCR efficiency 

(i.e., the number of copies of amplification product is doubled at each cycle). Typically, the 

slope ranges between −3.0 and −3.6. If the values fall outside of this range, see the 

Troubleshooting Guide, page 54, for more information. 

The Y-intercept 

The Y-intercept (b) indicates the expected CT value for a sample with a quantity value of 1 (for 

example, 1 ng/µL). 

The R2 value 

The R2 value is a measure of the fit of the data points to the regressed line. In general, the 

standard curve has an R2 value ≥0.990. Low R2 values (R2 ≤0.98) may occur for many different 

reasons. In case of low R2 values, see the Troubleshooting Guide, page 54, for more 

information. 

Internal control 

The internal control (IC)is intended to report chemistry or instrument failure, errors in assay 

setup, and the presence of inhibition in the sample. The IC system is designed to be more 

sensitive to inhibition than the specific target for human DNA. Therefore, the quantification will 

be valid even if some inhibition is present in the sample. In this case, the operator will get 

information both about the concentration of DNA in the sample and about the presence of 

inhibitors. Comparison of the CT value of the IC system for DNA standards with the CT values 

of the IC system for unknown samples can provide an indication of potential inhibition. At 

higher concentrations of inhibitor, the quantification data may be affected, and this must be 

considered for downstream applications. In general, the internal control can be interpreted in 

the following manner: 
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a) IC system shows normal amplification.  
No IC shift greater than specified is observed. 
No amplification of the Human, Degradation, and 
Male Targets is detectable. 

No or insufficient DNA was present. 

b) IC shift is greater than specified. 
Degradation Index is below threshold. 

Sample contains inhibitors. 
DNA is not degraded. 

c) IC shift is greater than specified. 
Degradation Index is above threshold. 

Sample contains inhibitors.  
DNA is possibly degraded. 
Note: Extremely high concentrations of inhibitors 
can inhibit amplification of the Degradation target 
and trigger the Degradation Index. 

Important: Internal laboratory validation with relevant inhibitors should be performed to 

determine criteria for detecting inhibition. 

Quantification of unknowns 

The Investigator Quantiplex Pro Kit can quantify a broad range of DNA amounts in a sample, 

from 200 ng/µL to approximately 0.5 pg/µL of human genomic DNA. When 2 µL of a sample 

with very low concentrations is loaded in a reaction, the well probably contains less than 

1 diploid human genome equivalent. In the low DNA concentration range, statistical effects, 

known as stochastic variations, can significantly affect the assay result. When using samples 

with low concentrations of DNA, make sure that as many replicates as possible are assayed 

in order to confirm the result. 

Quantification of female/male mixtures 

The Investigator Quantiplex Pro Kit provides high sensitivity to detect low amounts of male 

DNA even in a very high background of female DNA. The Mixture Index provides information 

on whether a sample is a female/male mixture. In general, the Mixture Index can be 

interpreted in the following manner: 

a) The sample has a Mixture Threshold below the 
index specified. 

The sample contains only male DNA or only low levels 
of female DNA. 

b) The sample has a Mixture Threshold above the 
index specified. 

The sample contains a possible male DNA/female 
DNA mixture. 
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Degradation status assessment 

Environmental degradation may occur with forensic casework samples and is a typical 

challenge in routine genetic fingerprinting. The Investigator Quantiplex Pro Kit contains a 

newly developed system for detection of DNA degradation. In general, the Degradation Index 

can be interpreted in following manner: 

a) The sample has a Degradation Threshold below 
the index specified. 
No IC shift is detected. 

DNA is most likely not degraded. 
The sample most likely contains no inhibitors. 

b) The sample has a Degradation Threshold below 
the index specified. 
IC shift is detectable above the threshold. 

DNA is most likely not degraded. 
The sample may contain inhibitors. 

c) The sample has a Degradation Threshold above 
the index specified. 
No IC shift is detected. 

DNA is most likely degraded. 
The sample most likely contains no inhibitors. 

d) The sample has a Degradation Threshold above 
the index specified. 
IC shift is detectable above the threshold. 

DNA may or may not be degraded. 
The sample contains inhibitors. 

Note: When 2 µL of a sample with very low concentrations is loaded in a reaction, the 

well probably contains less than 1 diploid human genome equivalent. In the low DNA 

concentration range, statistical effects, known as stochastic variations, can affect the 

assay. In case of degraded DNA with a very low DNA concentration, the Degradation 

target can be affected. If the Degradation target has an undetermined value, the sample 

will be tagged with “Possible Degradation”. Extremely high inhibitor concentrations can 

also affect the Degradation target and lead to a “Possible Degradation” flag. 
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Troubleshooting Guide 
This troubleshooting guide may be helpful in solving any problems that may arise. For more 

information, see also the Frequently Asked Questions page at our Technical Support Center: 

www.qiagen.com/FAQ/FAQList.aspx. The scientists in QIAGEN Technical Services are 

always happy to answer any questions you may have about either the information and 

protocols in this handbook or sample and assay technologies (for contact information, see 

back cover or visit www.qiagen.com). 

 Comments and suggestions 

No signal or one or more signals detected late in PCR 

a) Incorrect cycling conditions Always use the optimized cycling conditions specified in the protocols. Make 
sure to select ROX as the passive dye on QuantStudio 5 Real-Time PCR System. 

b) Pipetting error, missing or 
degraded reagent 

Check the storage conditions of the reagents. Repeat the assay. 

c) Incorrect or no detection 
step 

Make sure that fluorescence detection takes place during the combined 
annealing/extension step. 

d) Insufficient amount of 
starting template 

Increase the amount of template, if possible. Ensure that sufficient copies of 
the template DNA are present in the sample. 

e) Problems with starting 
template 

Check the storage conditions of the starting template DNA. 

Efficient removal of PCR inhibitors is essential for optimal results. Purify nucleic 
acids from your sample using an appropriate purification method. Ensure that 
all reagents, buffers and solutions used for isolating and diluting template 
nucleic acids are free from nucleases. 

f) Wrong detection 
channel/filter chosen 

Ensure that the correct detection channel is activated or the correct filter set is 
chosen for each reporter dye. Ensure that the chosen combination of reporter 
dyes is compatible with the selected detection channels or filter sets. 

g) Degraded control DNA Make new serial dilutions of the control DNA from the stock solution. Repeat 
the assay using the new dilutions. 

 

http://www.qiagen.com/
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 Comments and suggestions 

Differences in CT values or in PCR efficiencies between runs 

a) Incorrect cycling conditions Always start with the optimized cycling conditions specified in the protocols. 
Ensure that the cycling conditions include the initial step for activation of the 
DNA polymerase and the specified times for denaturation and 
annealing/extension. 

b) Analysis settings (e.g., 
threshold and baseline 
settings) not optimal 

Check the analysis settings (threshold and baseline settings) for each reporter 
dye. Repeat analysis using optimal settings for each reporter dye. 

No linearity in ratio of CT value/crossing point to log of the template amount 

 Amount of template in 
unknown sample too 
high 

Linearity is guaranteed within the range of the standard curve. If signals 
appear at very early CT values, dilute the sample and repeat the reaction. 

Increased fluorescence or CT value for no-template control 

a) Contamination of 
reagents 

Discard all the components of the assay (e.g., master mix). Repeat the assay 
using new components. 

b) Minimal probe 
degradation, leading to 
sliding increase in 
fluorescence 

Check the amplification plots, and adjust the threshold settings. 

c) Crosstalk problems Depending on the instrument, different techniques are used to avoid spectral 
crosstalk when using multiple fluorophores for multiplex assays. However, 
minimal crosstalk, as a result of residual spectral overlap, may be observed in 
the NTC wells, especially if the instrument is in need of calibration. 

Varying fluorescence intensity 

a) Contamination of real-
time cycler 

Reactions were contaminated with target DNA. Decontaminate the real-time 
workstations and the cycler according to the manufacturer’s instructions. Use 
new reagents and solutions. 

b) Real-time cycler no 
longer calibrated 

Recalibrate the real-time cycler according to the manufacturer’s instructions. 
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 Comments and suggestions 

c) Wavy curve at high 
template amounts for 
highly concentrated 
targets 

In the analysis settings, reduce the number of cycles used for background 
calculation (if the real-time cycler allows this) or reduce the amount of 
template. 

Slope for the standard curve differs significantly from –3.33 or R2 value is significantly less than 0.98–0.99 

a) Contamination of real-
time cycler 

Decontaminate the real-time cycler according to the manufacturer’s 
instructions. 

b) Real-time cycler and/or 
pipettes no longer 
calibrated 

Recalibrate the real-time cycler according to the manufacturer’s instructions. 

Calibrate pipettes to minimize pipetting variability. 

c) Wavy curve at high 
template amounts for 
highly concentrated 
targets 

In the analysis settings, reduce the number of cycles used for background 
calculation or reduce the amount of template. 

d) Problem with dilution of 
standards 

Ensure that the DNA standard is completely thawed and mixed thoroughly 
before use. 

Ensure that dilutions of the DNA standard are mixed thoroughly before 
removing each aliquot for the serial dilution. 

Always use a sample volume of 2 µL. 

Change pipette tips between each dilution step. 

e) Plate not sealed Carefully seal the plates to avoid evaporation. 

f) Error made during 
dilution of the DNA 
standard 

Verify all calculations, and repeat dilution of the DNA standard. 

g) Incorrect concentration 
values entered in the 
software 

Verify the concentrations for all samples used to generate the standard curve. 

h) Abnormal fluorescence Do not write on the plate. Use caution when handling plates. Wear gloves. 

i) Statistical variation Some variation in the reaction is normal, particularly when the DNA target is 
present at a low copy number. Perform at least duplicates for the standard 
curve to minimize the effect of this variation. 
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Appendix: Alternative Standard Curves 
Table 10. Alternative 5-point standard curve (10x dilution) 

 Serial dilution of control DNA 
(ng/µL) 

Amount of control DNA 
(µL) 

QuantiTect Nucleic Acid Dilution Buffer 
(µL) 

 

50 Undiluted DNA – 

5 5 45 

0.5 5 45 

0.05 5 45 

0.005 5 45 

  

Table 11. Alternative 6-point standard curve (9x dilution) 

 Serial dilution of control DNA 
(ng/µL) 

Amount of control DNA 
(µL) 

QuantiTect Nucleic Acid Dilution Buffer 
(µL) 

 

50 Undiluted DNA – 

7.1429 5 40 

1.0204 5 40 

0.0686 5 40 

0.0076 5 40 

0.0030 5 40 
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Table 12. Alternative 7-point standard curve (5x dilution) 

 Serial dilution of control DNA 
(ng/µL) 

Amount of control DNA 
(µL) 

QuantiTect Nucleic Acid Dilution Buffer 
(µL) 

 

50 Undiluted DNA – 

10 10 40 

2 10 40 

0.4 10 40 

0.08 10 40 

0.016 10 40 

0.0032 10 40 
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Ordering Information 

Product Contents Cat. no. 

Investigator Quantiplex Pro Kit (200) Quantiplex Pro Reaction Mix, 
Quantiplex Pro Primer Mix, Male 
Control DNA M1, QuantiTect 
Nucleic Acid Dilution Buffer 

387216 

Investigator Quantiplex Pro 
Calibration Kit 

Calibration Standard FAM, JOE, 
ATTO 550, ROX, ATTO 647N, 
and, Quantiplex Pro Calibration 
Buffer 

387416 

Related products  

Investigator Quantiplex Pro RGQ Kit 
(200) 

Quantiplex Pro RGQ Reaction 
Mix, Quantiplex Pro RGQ Primer 
Mix, Male Control DNA M1, 
QuantiTect Nucleic Acid Dilution 
Buffer 

387316 

Investigator 24plex QS Kit (100)* Primer mix, Fast Reaction Mix 
2.0, Control DNA, allelic ladder, 
DNA size standard, and 
Nuclease-free water 

382415 

Investigator 26plex QS Kit (100)* Primer mix, Fast Reaction Mix 
3.0, Control DNA, allelic ladder, 
and Nuclease-free water 

382615 

Investigator ESSplex SE QS Kit (100)* Primer Mix, Fast Reaction Mix 
2.0, Control DNA, allelic ladder, 
DNA size standard, and 
Nuclease-free water 

381575 

* Larger kit sizes available; please inquire 
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Product Contents Cat. no. 

Investigator Argus X-12 QS Kit (25)* Primer mix, Fast Reaction Mix 
2.0, Control DNA, allelic ladder, 
DNA size standard, and 
Nuclease-free water 

383223 

Investigator Argus Y-28 QS Kit (100)* Primer mix, Fast Reaction Mix 
3.0, Control DNA, allelic ladder, 
DNA size standard, and 
Nuclease-free water 

383625 

* Larger kit sizes available; please inquire. 

For up-to-date licensing information and product-specific disclaimers, see the respective 

QIAGEN kit handbook or user manual. QIAGEN kit handbooks and user manuals are 

available at www.qiagen.com or can be requested from QIAGEN Technical Services or your 

local distributor. 
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Document Revision History 

 

 Date Changes  

04/2023 Initial release as handbook HB-3355, expanded from 
supplementary protocol HB-2700. 
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Limited License Agreement for Quantiplex Pro Kit 

Use of this product signifies the agreement of any purchaser or user of the product to the following terms: 

1. The product may be used solely in accordance with the protocols provided with the product and this handbook and for use with components contained in the 
panel only. QIAGEN grants no license under any of its intellectual property to use or incorporate the enclosed components of this panel with any components not 
included within this panel except as described in the protocols provided with the product, this handbook, and additional protocols available at www.qiagen.com. Some 
of these additional protocols have been provided by QIAGEN users for QIAGEN users. These protocols have not been thoroughly tested or optimized by QIAGEN. 
QIAGEN neither guarantees them nor warrants that they do not infringe the rights of third-parties.  

2. Other than expressly stated licenses, QIAGEN makes no warranty that this panel and/or its use(s) do not infringe the rights of third-parties. 

3. This panel and its components are licensed for one-time use and may not be reused, refurbished, or resold. 

4. QIAGEN specifically disclaims any other licenses, expressed or implied other than those expressly stated. 

5. The purchaser and user of the panel agree not to take or permit anyone else to take any steps that could lead to or facilitate any acts prohibited above. QIAGEN 
may enforce the prohibitions of this Limited License Agreement in any Court, and shall recover all its investigative and Court costs, including attorney fees, in any action 
to enforce this Limited License Agreement or any of its intellectual property rights relating to the panel and/or its components. 

For updated license terms, see www.qiagen.com. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Trademarks: QIAGEN®, Sample to Insight®, Investigator®, Q-Bond®, Quantinova®, Quantiplex® (QIAGEN Group); Applied Biosystems®, QuantStudio™, (Thermo Fisher 
Scientific or its subsidiaries); Taqman® (Roche Group). Registered names, trademarks, etc. used in this document, even when not specifically marked as such, are not to be 
considered unprotected by law.  

04-2023 HB-3355-001 © 2023 QIAGEN, all rights reserved. 
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Ordering www.qiagen.com/shop | Technical Support support.qiagen.com | Website www.qiagen.com 
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